




Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©January 2007

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain U.S. pat-
ents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of
this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home
or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineer-
ing or disassembly is prohibited.
Intel, Celeron, and Intel Core are trademarks/registered trademarks of Intel Corporation.
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FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
II



Preface
IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There 
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may 

explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit DC Output 100 - 240V, 50 - 60Hz, 20V, 3.25A 

(65W) minimum AC/DC Adapter.

CAUTION
Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, 
TELECOMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class 1 Product
III
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do not place anything heavy 
on the computer.

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place 
where foreign matter or mois-
ture may affect the system.

Don’t use or store the com-
puter in a humid environment.

Do not place the computer on 
any surface that will block the 
Vents/Fan Intakes.
IV



Preface
3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget 
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

5. Take care when using peripheral devices.

Do not turn off the power 
until you properly shut down 
all programs.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance 
on your computer.

Use only approved brands of 
peripherals.

Unplug the power cord before 
attaching peripheral devices.
V
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Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a steady, 

uninterrupted power supply. If you are unsure of your local power specifications, consult 
your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong 
is an important safety feature; do not defeat its purpose. If you do not have access to a 
compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not by 
its wire.

• Make sure the socket and any extension cord(s) you use can support the total current load 
of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external power sup-
plies (i.e. AC/DC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
VI
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even 

if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly 
result in fire.

• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
VII
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
VIII
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, 

check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters 

and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-

ware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer
from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.
IX
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On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
X
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the 
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on 
a footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles 

when you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent 

and short breaks are better than fewer and longer breaks.
XI
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.
XII
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Quick Start Guide 1
Chapter 1: Quick Start Guide
Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, 
optical device, 4-in-1 card reader, ExpressCard/34/54), Auto Mail Program, TouchPad & 
Mouse, Audio & Printer.

• Chapter 3 The computer’s power saving options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 Instructions for upgrading your computer.
• Chapter 7 A quick guide to the computer’s Wireless LAN, Bluetooth and PC Camera modules (some of 

which may be optional depending on your purchase configuration).
• Chapter 8 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external 

devices.
• Appendix B Information on the Intel Video driver controls.
• Appendix C The computer’s specification.
• Appendix D Information on the Windows XP OS.
Overview 1 - 1
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Model Differences
This notebook series includes two different model types (each model includes two design styles). The models
differ slightly in design style including the LCD type, and the location of the card reader (the easiest way to dif-
ferentiate between the model types is the location of the card reader).

Table 1 - 1 - Model Differences

Feature Model A Model B

LCD Type
15.0" XGA (1024 * 768) TFT

OR
15.0" SXGA+ (1400 * 1050) TFT

14.0" WXGA (1280 * 768) TFT
OR

14.1" WXGA (1440 * 900) TFT

4-in-1 Card Left Side Front

Design 
Styles
1 - 2 Overview
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on
page 6 - 1 in the User’s Manual. You may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in this Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand every-
thing the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page  A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the

 symbol. Also please note the safety and handling instructions as indicated in the Preface.

Notes

Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features. 
Overview 1 - 3
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Not Included
Operating Systems (e.g. Windows Vista/Windows XP) and applications (e.g. word processing, spreadsheet and
database programs) have their own manuals, so please consult the appropriate manuals.

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed in Table 4 - 1, on page 4 - 3. You will be unable to use most advanced controls until the necessary drivers and util-
ities are properly installed. If your system hasn’t been properly configured (your service representative may have already
done that for you), refer to “What to Install” on page 4 - 1 for installation instructions.

Ports and Jacks

See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.
1 - 4 Overview
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System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the following operating systems are sup-
ported.

Table 1 - 2 - Operating Systems Supported

*Note: For information on the Windows XP OS (specifically power, video and driver information) see “Win-
dows XP Information” on page D - 1.

Operating System & Version Supported Note

*Windows XP (Home or Professional) Yes

Windows Vista Home Basic
x32 Yes

In order to run Windows Vista  without
limitations or decreased performance, your
computer requires a minimum 1GB of
system memory (RAM).

x64 No

Windows Vista Home Premium
x32 Yes

x64 No

Windows Vista
Business/Enterprise/Ultimate

x32 Yes

x64 No
Overview 1 - 5
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System Startup
1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack on the right of the computer, then plug the AC power cord into an 

outlet, and connect the AC power cord to the AC/DC adapter.
5. Raise the lid/LCD (you will need to press the LCD latch to release the lid of Model A computers) to a 

comfortable viewing angle, and press the power button to turn the computer “on”.
6. Adjust the LCD panel to a comfortable viewing angle.
7. The LED Power & Communication indicators show the power and battery status of the computer, and give 

notification of e-mail received.

Figure 1 - 1 - Computer with AC/DC Adapter Plugged-In

Shutdown

Note that you should always shut your computer down by choos-
ing the Shut Down command from the Lock menu in Windows
Vista. This will help prevent hard disk or system problems.
1 - 6 System Startup
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System Map: Model A - LCD Panel Open

Figure 1 - 2 - Model A - Top View with LCD Panel Open
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1. Optional Built-In PC Camera
2. LCD
3. LED Status Indicators
4. Hot-Key Buttons
5. Power Button
6. Keyboard
7. Built-In Microphone
8. TouchPad and Buttons
9. LED Power & Communication 

Indicators

4
5

3

Note: Only One Design Style is Pictured 

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the key combinations
to toggle power to the
WLAN/Bluetooth modules,
and check the status indi-
cator icon to see if the mod-
ules are powered on or not
(see Table 1 - 4, on page 1
- 9/Table 1 - 6, on page 1 -
11).
System Map: Model A - LCD Panel Open 1 - 7
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System Map: Model B - LCD Panel Open

Figure 1 - 3 - Model B - Top View with LCD Panel Open
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1

7

8

4

1. Optional Built-In PC Camera
2. LCD
3. Speakers
4. LED Status Indicators
5. Hot-Key Buttons
6. Power Button
7. Keyboard
8. TouchPad and Buttons
9. LED Power & Communication 

Indicators
10. Built-In Microphone

6

9

3

5 6

4

10

Note: Only One Design Style is Pictured 

3

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the key combinations
to toggle power to the
WLAN/Bluetooth modules,
and check the status indi-
cator icon to see if the mod-
ules are powered on or not
(see Table 1 - 4, on page 1
- 9/Table 1 - 6, on page 1 -
11).
1 - 8 System Map: Model B - LCD Panel Open
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LED Indicators
The two sets of LED indicators (LED Status Indica-
tors and LED Power & Communication Indicators)
on the computer display helpful information about the
current status of the computer.

Table 1 - 3 - LED Status Indicators

Table 1 - 4 - LED Power & Communication Indicators

Icon Color Description

Green Number Lock Activated (to activate 
press Fn & NumLk)

Green Caps Lock Activated

Green Scroll Lock Activated (to activate 
press Fn & ScrLk)

Swap Battery (Model A Option)

The  icon will provide additional information on the
optional swap battery status. See “Swap Battery (Op-
tional for Model A Only)” on page 3 - 16 for details.

Icon Color Description

Green The Computer is On

Blinking 
Green The Computer is in Sleep Mode

Orange
The AC/DC Adapter is Plugged 
In & the Computer is Powered 

Off

Orange The AC/DC Adapter is Plugged 
In & the Battery is Charging

Blinking 
Orange

The Battery has Reached 
Critically Low Power Status

Green The Battery is Fully Charged

Blinking 
Green

New Mail Has Arrived
(WinXP Only)

Green Hard Disk Activity

Green The WLAN Module is Powered 
On

Orange The Bluetooth Module is 
Powered On
LED Indicators 1 - 9
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Hot-Key Buttons & Keyboard
These buttons give instant access to the default Inter-
net browser and e-mail program, and to a user-defined
application, with one quick button press. To use the
“user-defined application Hot-Key Button”, you must
install the driver (see “Hot-Key” on page 4 - 6).

Table 1 - 5 - Hot-Key Buttons

See “Application Hot-Key” on page 2 - 8 for configu-
ration instructions.

Note: The hot-key buttons may appear slightly differ-
ent from those illustrated in Table 1 - 5, depending on
your model/design.
The keyboard has an embedded numerical keypad for

easy numeric data input, and features Function Keys to
allow you to change operational features instantly (see
Figure 1 - 4).

Figure 1 - 4 - Keyboard

Hot-Key Function

Activate the user specified application e.g. 
Microsoft Word or Excel

 Activate the Default E-Mail Program

Activate the Default Internet Browser

Fn Key

Function Keys
NumLk & 
ScrLk Keys

Numeric 
Keypad

Other Keyboards

If your keyboard is damaged or you just want to make a
change, you can use any standard USB keyboard. The
system will detect and enable it automatically. However
special functions/hot keys unique to the system’s regular
keyboard may not work.
1 - 10 Hot-Key Buttons & Keyboard
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Function Keys
To use the function keys, press and hold the Fn key, then press the appropriate function key (F1 - F12 etc.).

Table 1 - 6 - Function Keys

Key Function Key Function

Fn Function Key Fn + F8 Decrease LCD Brightness

Fn + F1 TouchPad Toggle Fn + F9 Increase LCD Brightness

Fn + F3 Mute Toggle Fn + F10 PC Camera Power Toggle

Fn + F4 Sleep Toggle Fn + F11 Wireless Power Toggle

Fn + F5 Decrease Audio Volume Fn + F12 Bluetooth Power Toggle

Fn + F6 Increase Audio Volume Fn + NumLk Number Lock Toggle

Fn + F7 Display Toggle Fn + ScrLk Scroll Lock Toggle

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters. These special char-
acters can only be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard) will
not work. Make sure that NumLk is on.
Function Keys 1 - 11
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System Map: Front & Rear Views

Figure 1 - 5 - Front & Rear Views

1

6
7

5

2

4

Model A

3

Model B

1

1. LED Power & 
Communication 
Indicators

2. LCD Latch 
(Model A Only)

3. 4-in-1 Card Reader 
(Model B Only)

4. External Monitor Port
5. S-Video-Out Jack
6. Security Lock Slot
7. Battery

4-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / MS Pro (Memory Stick Pro)
1 - 12 System Map: Front & Rear Views
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System Map: Left View

Figure 1 - 6 - Left View

3
1 52 4 6 8

Model A - Left

Model B - Left

1 2
3 4 5 6

7

3

3

1. RJ-45 LAN Jack
2. Vent/Fan Intake
3. 2 * USB 2.0 Ports
4. S/PDIF-Out Jack
5. Line-In Jack
6. Mini-IEEE 1394 Port
7. ExpressCard Slot (see 

page 2 - 7)
8. 4-in-1 Card Reader 

(Model A Only)

7

4-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / MS Pro (Memory Stick Pro)

ExpressCard Slot

The ExpressCard Slot accepts either ExpressCard/34 or ExpressCard/54 formats.
System Map: Left View 1 - 13
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System Map: Right View 

1

Changing DVD Regional Codes

Go to the Control Panel and double-click click De-
vice Manager (Hardware and Sound), then click
the + next to DVD/CD-ROM drives. Double-click on
the DVD-ROM device to bring up the Properties di-
alogue box, and select the DVD Region (tab) to
bring up the control panel to allow you to adjust the
regional code (see “DVD Regional Codes” on
page 2 - 5).

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.

CD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unex-
pected power interruption) you may push the end of a straight-
ened paper clip into the emergency eject hole. Do not use a
sharpened pencil or similar object that may break and become
lodged in the hole. 

Media Warning

Don’t try to remove a floppy disk/CD/DVD while the system is
accessing it. This may cause the system to “crash”.

4 5
632

Figure 1 - 7 - Right View
1. Headphone-Out Jack
2. Microphone-In Jack
3. USB 2.0 Port
4. RJ-11 Phone Jack
5. Optical Device Drive Bay 

(for CD/DVD Device - see 
page 2 - 3)

6. DC-In Jack
1 - 14 System Map: Right View
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System Map: Bottom View 

2

3

CPU

The CPU is not a user ser-
viceable part. Opening this
compartment, or access-
ing the CPU in any way,
may violate your warranty.

Overheating

To prevent your computer
from overheating make
sure nothing blocks the
Vent/Fan Intake while the
computer is in use.

Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery
at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 9 for full instruc-
tions.

4

1

Model A

5 5

Figure 1 - 8 - Bottom View
1. Vent/Fan Intake
2. Battery
3. Module Bay Cover
4. Hard Disk Cover
5. Speakers (Model A Only)

1

1

2

3

4

Model B
1

1

1

System Map: Bottom View 1 - 15
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Windows Vista Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon , and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers listed
in Table 4 - 1, on page 4 - 3. To see all controls it may be necessary to toggle to Classic View on.

Figure 1 - 9 - Start Menu & Control Panel

Click here to toggle Classic View 
1 - 16 Windows Vista Start Menu & Control Panel
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Video Features
You can switch display devices, and configure display options, from the Display Settings control panel (in Per-
sonalization) in Windows Vista as long as the appropriate Intel video driver is installed. For more detailed vid-
eo information see “Intel Video Driver Controls” on page B - 1.

To access Display Properties in Windows Vista:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click 

Personalization > Display Settings).
3. Move the slider to the preferred setting in Resolution:  (Figure 1 - 10 on page 1 - 18).
4. Click the arrow, and scroll to the preferred setting In Colors: (Figure 1 - 10 on page 1 - 18).
5. Click Advanced Settings (button)  (Figure 1 - 10 on page 1 - 18) and click Intel(R) GMA Driver for mobile 

(tab).
6. Click Graphics Properties (button)  (Figure 1 - 10 on page 1 - 18) to access the Intel GMA control panel 

(this control panel can also be accessed by double-clicking Intel(R) GMA Driver for mobile in Classic View).
7. The Intel GMA control panel can also be accessed by clicking the icon  in the taskbar and selecting Graphics 

Properties from the menu.

Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display or
TV as your display device. A VGA monitor/Flat Panel Display connects to the external monitor port, a TV to
the 7-Pin S-Video-Out Jack. See Table 1 - 7, on page 1 - 18 for a summary of the display modes available. To
adjust the total video memory used by the computer (Pre-Allocated + Fixed + DVMT) see “Total Graphics
Memory: (Advanced Menu)” on page 5 - 9.

1
2

3

4

Video Features 1 - 17
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Figure 1 - 10 - Display Properties Desktop

Table 1 - 7 - Display Options

Intel Display Mode Description

Single Mode One of the connected displays is used as the display device

Intel(R) Dual Display Clone Mode Both connected displays output the same view and may be configured independently

Extended Desktop Mode Both connected displays are treated as separate devices, and act as a virtual desktop

1 2

3

4

1 - 18 Video Features
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Power Options
The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 16) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change Plan Settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 9.

Figure 1 - 11 - Power Options

Note: Sleep is the default power saving state in Windows Vista
Power Options 1 - 19



Quick Start Guide1
1 - 20



Features & Components

2
Chapter 2: Features & Components
Overview
Read this chapter to learn more about the following main features and components
of the computer:

• Hard Disk Drive
• Optical (CD/DVD) Device
• 4-in-1 Card Reader
• ExpressCard Slot
• Application Hot-Key
• TouchPad and Buttons/Mouse
• Audio Features
• Adding a Printer
Overview 2 - 1
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 Hard Disk Drive
The hard disk drive is used to store your data in the computer. The hard disk can be
taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height
of 9.5 mm.

The hard disk is accessible from the bottom of your computer as seen below. For fur-
ther details see “Upgrading the Hard Disk Drive” on page 6 - 5.

Power Safety

Before attempting to ac-
cess any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

Figure 2 - 1
Hard Disk Location

Hard Disk

Model A Model B
2 - 2 Hard Disk Drive
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Optical (CD/DVD) Device
There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de-
vice will depend on the module you purchased (see “Storage” on page C - 3). The
optical device is usually labeled “Drive D:” and may be used as a boot device if
properly set in the BIOS (see “Boot Menu” on page 5 - 12).

Loading Discs
To insert a CD/DVD, press the open button  and carefully place a CD/DVD onto
the disc tray with label-side facing up (use just enough force for the disc to click onto
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you
are ready to start. The busy indicator  will light up while data is being accessed,
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency eject hole

 to open the tray.

Sound Volume 
Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows. Click the Volume
icon on the taskbar to
check the setting (see
“Audio Features” on
page 2 - 10).

 Figure 2 - 2
Optical Device

1

2

3

12 3
Optical (CD/DVD) Device 2 - 3
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 Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be
accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.

CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency eject
hole. However please
do NOT use a sharp-
ened pencil or similar
object that may break
and become lodged in
the hole.

Disk Eject Warning

Don’t try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.
2 - 4 Optical (CD/DVD) Device
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DVD Regional Codes
To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 14.

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South 
Africa, Middle East & Egypt

3
South-East Asia, Taiwan, South 

Korea, The Philippines, Indonesia, 
Hong Kong

4
South & Central America, Mexico, 

Australia, 
New Zealand

5 N Korea, Russia, Eastern Europe, 
India & Most of Africa

6 China

Table 2 - 1
DVD Regional Coding

 Figure 2 - 3
DVD Regions
Optical (CD/DVD) Device 2 - 5
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 4-in-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the PCMCIA/Card Reader
Card driver (see “ExpressCard/Card Reader” on page 4 - 6).

• MMC (MultiMedia Card)
• SD (Secure Digital)
• MS (Memory Stick)
• MS Pro (Memory Stick Pro)

Card Reader Cover

Make sure you keep the
cover in the card reader
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the card read-
er.

 Figure 2 - 4
Left & Front Views

1. Card Reader

Model B (Front)

Model A (Left)

1

1

2 - 6 4-in-1 Card Reader
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ExpressCard Slot
The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/
34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Cards).

ExpressCard/54 is used for applications which require a larger interface slot, e.g.
CompactFlash card reader. The number denotes the card width; 54mm for the Ex-
press Card/54 and 34mm for the ExpressCard/34. Make sure you install the Express-
Card driver (see “ExpressCard/Card Reader” on page 4 - 6).

Inserting and Removing ExpressCards
• Align the ExpressCard with the slot and push it in until it locks into place.
• To remove an ExpressCard, simply press the card to eject it.

 Figure 2 - 5
ExpressCard Slot

ExpressCard Slot 
Cover

Make sure you keep the
cover in the Express-
Card slot when not in
use. This will help pre-
vent foreign objects and/
or dust getting in to the
ExpressCard Slot.
ExpressCard Slot 2 - 7
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 Application Hot-Key
The hot-key buttons give instant access to the default Internet browser and e-mail
program, and to a user-defined application with one quick button press. To configure
a program to open when the application hot-key  is pressed follow the instruc-
tions below.

1. Right click the Hot-Key driver icon  in the taskbar.
2. Select Setup from the menu, scroll to Application 1 and click to select Custom. 

3. An Open dialog box will appear on the screen.

4. Browse to the directory where the desired application.exe (see the sidebar) 
program exists.

5. Double-Click on the program file or choose Open.

Application.exe

You will need to locate
the actual application
executable (.exe) file,
not just the shortcut. To
find the application right-
click its shortcut icon
and click Properties.
Click the shortcut (tab)
and see where the exe-
cutable file is located by
clicking the Open File
Location (button).

 Figure 2 - 6
Hot-Key 

Configuration 
Screens
2 - 8 Application Hot-Key
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TouchPad and Buttons/Mouse
The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in
much the same way as a two-button mouse.

Configuring the TouchPad and Buttons
Once you have installed the TouchPad driver configure the functions by double-
clicking the TouchPad driver icon  in the taskbar. Alternatively click Start and
click Control Panel, and then double-click the Mouse icon (Hardware and
Sound). The TouchPad may be toggled on/off by means of the Fn + F1 key combi-
nation.

Mouse Driver

If you are using an exter-
nal mouse your operat-
ing system may be able
to auto-configure your
mouse during its instal-
lation or only enable its
basic functions. Be sure
to check the device’s
user documentation for
details.

 Figure 2 - 7
Mouse Properties
TouchPad and Buttons/Mouse 2 - 9
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 Audio Features
You can configure the audio options on your computer from the Sound  control
panel in Windows, or from the Realtek HD Audio Manager  icon in the taskbar/
control panel (right-click the taskbar icon  to bring up an audio menu). The volume
may also be adjusted by means of the Fn + F5/F6 key combination. 

Sound Volume 
Adjustment

The sound volume level
is set using the volume
control within Windows
(and the volume func-
tion keys on the comput-
er). Click the volume
icon in the taskbar to
check the setting.

 Figure 2 - 8
Realtek Audio 

Manager

Right-click the icon 
to access the menu 
above.
2 - 10 Audio Features
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Adding a Printer
The most commonly used peripheral is a printer. The following conventions will
help you to add a printer, however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer
Most current printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-

tridge etc.). 
2. Turn ON the computer.
3. Turn ON the printer. 
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you 

to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are in the sidebar,
however you will need to purchase a parallel to USB converter.

Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer’s
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
Adding a Printer 2 - 11
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Chapter 3: Power Management
Overview
To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer
(the monitor and hard disk drive) or the whole system. This chapter covers:

• The Power Sources
• Turning on the Computer
• Power Plans
• System Power Options
• Configuring the Power Buttons
• Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.

OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system. 

(Note: All pictures used
on the following pages
are from the Windows
Vista OS.)
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the right of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the 

AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do I completely discharge the battery?”
on page 3 - 13).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 9.
3 - 2 The Power Sources
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Turning on the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Sleep/Hibernate hot-
key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will shut the computer down). Use Power Options
(Hardware and Sound menu) control panel in Windows Vista to configure this fea-
ture.

Shut Down

Note that you should al-
ways shut your comput-
er down by choosing the
Shut Down command
from the Lock menu in
Windows Vista. This
will help prevent hard
disk or system prob-
lems.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the pow-
er button for 4 seconds, or longer, to force the system to turn itself off.

Power Button Sleep

Sleep  is the default power mode when the power button is pressed for less than 4 seconds.
You may configure the options for the power button from the Power Options (Hardware
and Sound menu) control panel in Windows Vista (see your OS’s documentation, or
“Configuring the Power Buttons” on page 3 - 8 for details).
Turning on the Computer 3 - 3
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

Resuming 
Operation

If the display is off the
system can resume by
pressing any key on the
keyboard.

The system can resume
from Sleep mode by
pressing the Sleep But-
ton key combination (Fn
+ F4), or power button.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure 3 - 1
Power Plan 

Advanced Settings
3 - 4 Power Plans
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Figure 3 - 2
Power Plans
Power Plans 3 - 5



Power Management

3

System Power Options
You can use the system power options to stop the computer’s operation and restart
where you left off. The system features Sleep and Hibernate power saving states
(Hibernate will need to be enabled from power plan Advanced Settings see Figure
3 - 1 on page 3 - 4).

Hibernate vs. Shut Down
Hibernate and Shut Down are the same in that the system is off and you need to press
the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left off
(what was on your desktop) without reopening the application(s) and file(s) you last
used.

You can use either method depending on your needs. 

Sleep vs. Hibernate
If you want to stay away from your work for just a while, you can put the system into
Sleep instead of in hibernation. It takes a longer time to wake up the system from
Hibernate mode than from Sleep mode. Sleep will effectively act as Hibernate if
the computer battery becomes depleted (see “Sleep Mode & Mobile PC Battery” on
page 3 - 7).

Sleep Button

The Sleep Button 
in the Start Menu (not
available in Classic
View) can be used to
send the computer into
Sleep.

Note that Sleep is the
default power saving
state in Windows Vista.
3 - 6 System Power Options
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Sleep
Sleep uses very little system power, and takes a short time to return to full operation.
After an extended period of time in Sleep the computer will save the contents of sys-
tem memory (e.g. any open documents and applications) to the hard disk and shut
the system down. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep mode to save power.

Hibernate
Hibernate uses no power and saves all of your information on a part of the hard disk
before it turns the system off. Although it saves the most power it takes the longest
time to return to full operation. You can set your computer to automatically enter Hi-
bernate when the battery power is almost depleted. You will need to enable Hiber-
nate mode from the Advanced Settings in power plans, or you put the system
directly into Hibernate mode from the Lock Menu. The system will resume from
Hibernate mode by pressing the power button.

Sleep Mode & 
Mobile PC Battery

A mobile PC in Sleep
uses very little battery
power. 

After an extended peri-
od of time the computer
will save any open docu-
ments and applications
to hard disk.

Figure 3 - 3
Lock Menu 
Hibernate
System Power Options 3 - 7
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Configuring the Power Buttons
The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the
computer in to either Sleep or Hibernate. In Sleep, the LED  will blink green.
In Hibernate the LED will be off (battery) or orange (AC/DC adapter). If the only
the display is turned off, the LED will remain green.

Password 
Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3 - 4
Power Options 
Define Power 

Buttons
3 - 8 Configuring the Power Buttons
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Battery Information
Please follow these simple guidelines to get the best use out of your battery.

Battery Power
Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

Click the battery icon  in the taskbar to see the current battery level and charge
status.

Low Battery 
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure 3 - 5
Battery Icon 

(Taskbar) & Battery 
Advanced Settings
Battery Information 3 - 9
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Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that 

this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD 
brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth, modem or communication applications when they are 
not being used.

• Disconnect/remove any unnecessary external devices e.g. USB devices, PC 
Cards etc.

Windows Mobility 
Center

The Windows Mobility
Center control panel pro-
vides an easy point of ac-
cess for information on
battery status, power plans
used and wireless device
status etc.

Figure 3 - 6
Windows Mobility 

Center
3 - 10 Conserving Battery Power
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason see “Removing the Battery” on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 13 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 7 for information on the battery charge status, and to “Battery In-
formation” on page 3 - 9 for more information on how to maintain and properly
recharge the battery pack.)
Battery Life 3 - 11
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.
3 - 12 Battery Life
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after saving it) and click Change advanced power 

settings.

Figure 3 - 7
Power Plan Create
Battery Life 3 - 13
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4. Click Change plan settings (after saving it) and click Change advanced power 
settings.

5. Scroll down to Battery and click + to expand the battery options.
6. Choose the options below (click Yes if a warning appears):

• Low battery levels = 0%
• Critical battery Levels = 0%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut Down
• Critical battery action (Plugged in) = Do Nothing

Figure 3 - 8
Power Options 

Advanced Settings - 
Battery
3 - 14 Battery Life
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.
Battery Life 3 - 15
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Swap Battery (Optional for Model A Only)
If you have included the optional swap battery in your purchase option it will allow
you to change batteries on your computer without having to shut the computer down.
The swap battery’s total operational time is approximately three minutes; however
the swap battery life is dependent upon many factors (see sidebar).

Swapping Batteries
1. Go to the Power Options control panel in Windows.
2. Click “Choose what closing the lid does” from the menu on the left.
3. Select Sleep as the option for “When I close the lid”.

4. Click Save changes, and close the cover of the notebook.
5. The computer will enter Sleep mode (the  LED will blink green*).
6. Remove the currently installed battery, and install the replacement battery 

(see page 6 - 3) within the 3 minute (approx.) operational period.
7. Open the notebook cover and the system will resume.

*Swap Battery 
Indicator

The  icon will blink
green for about one
minute, and will then
change to blink orange
for a further two minutes
before the computer
shuts down. These
times are intended as
guidelines only, and
may vary depending
upon programs and pe-
ripheral devices being
used.

Figure 3 - 9
Power Options

(When I Close the  
Lid)
3 - 16 Swap Battery (Optional for Model A Only)
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utili-
ties essential to the operation or improvement of some
of the computer’s subsystems. The system takes ad-
vantage of some newer hardware components for
which the latest versions of most available operating
systems haven’t built in drivers and utilities. Thus,
some of the system components won’t be auto-config-
ured with an appropriate driver or utility during oper-
ating system installation. Instead, you need to
manually install some system-required drivers and
utilities. 

What to Install
The Device Drivers & Utilities + User’s Manual CD-
ROM contains the drivers and utilities necessary for
the proper operation of the computer. Table 4 - 1, on
page 4 - 3 lists what you need to install manually ac-
cording to your choice of the operating system, and it
is very important that the drivers are installed in
the order indicated.

Module Driver Installation
The procedures for installing drivers for the Wireless
LAN and PC Camera modules are provided in “Mod-
ules & Options” on page 7 - 1. Make sure that the
drivers are installed in the order indicated in Table 4 -
1, on page 4 - 3. Only install drivers for modules in-
cluded in your purchase option.
What to Install 4 - 1
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Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
CD-ROM and click Install Vista Drivers (button).

If you wish to install the drivers manually see page 4 -
4.

Figure 4 - 1 - Drivers Installer Screen 1

1. Check the driver installation order from Table 4 - 1, 
on page 4 - 3 (the drivers must be installed in 
this order) which is the same as that listed in the 
Drivers Installer menu below.

2. Click to select the driver you wish to install, after 
installing each driver it will become grayed out (if 
you need to reinstall any driver, click the Unlock 
button).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following 
pages.

 
Figure 4 - 2 - Drivers Installer Screen 2
4 - 2 Driver Installation
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Table 4 - 1 - Driver Installation

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and 
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

4. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.

Driver Page #

 Chipset Page 4 - 5

Video Page 4 - 5

Audio Page 4 - 5

Modem Page 4 - 6

LAN Page 4 - 6

TouchPad Page 4 - 6

ExpressCard/Card Reader Page 4 - 6

Hot-Key Page 4 - 6

Wireless LAN Module Page 7 - 2

PC Camera Module Page 7 - 11
Driver Installation 4 - 3
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Manual Driver Installation
If you wish to install the drivers manually, click the Exit button to quit the Drivers Installer application, and
then browse to the executable file in the location listed in the table below and follow the installation procedure
for each driver. Note that X is the drive letter assigned to the CD/DVD-ROM drive.
.

Table 4 - 2 - Driver Location

Driver Driver Location

Chipset Vista 32bit: X:\Drivers\32bit\01_Chipset\Setup.exe

Video Vista 32bit: X:\Drivers\32bit\02_Video\Setup.exe

Audio Vista 32bit: X:\Drivers\32bit\03_Audio\Setup.exe

Modem Vista 32bit: X:\Drivers\32bit\04_Modem\ssetup.exe

LAN Vista 32bit: X:\Drivers\32bit\05_Lan\setup.exe

TouchPad Vista 32bit: X:\Drivers\32bit\06_TouchPad\setup.exe

ExpressCard/Card Reader Vista 32bit: X:\Drivers\32bit\07_CardReader\setup.exe

Hot-Key Vista 32bit: X:\Drivers\32bit\08_Hotkey\Setup.exe

Wireless LAN Module Vista 32bit: X:\Drivers\32bit\Option\09_WLAN(Intel)\iProDifX.exe

PC Camera Module Vista 32bit: X:\Drivers\32bit\Option\10_Camera\setup.exe
4 - 4 Driver Installation
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User Account Control (Win Vista)
If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

New Hardware Found
If you see the message “New Hardware Found”
(Found New Hardware Wizard) during the installation
procedure (other than when outlined in the driver in-
stall procedure), click Cancel to close the window, and
follow the installation procedure as directed.

Driver Installation Procedure

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next.
3. Click Finish to restart the computer.

Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Audio
1. Click 3.Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.
Driver Installation 4 - 5
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Modem
1. Click 4.Install Modem Driver > Yes.
2. Click OK.
3. The modem is ready for dial-up configuration.

LAN
1. Click 5.Install Lan Driver > Yes. 
2. Click Next > Install.
3. Click Finish.

TouchPad
1. Click 6.Install TouchPad Driver > Yes. 
2. Click Next > Next.
3. Click Finish to restart the computer.
4. You may then configure your TouchPad as out-

lined in “TouchPad and Buttons/Mouse” on 
page 2 - 9.

ExpressCard/Card Reader
1. Click 7.Install CardReader Driver > Yes.
2. Click Next.
3. Click the button to accept the license, and then 

click Next.
4. Click Finish.

Hot-Key
1. Click 8.Install Hotkey Driver > Yes.
2. Click Next.
3. Click Finish to restart your computer.
4. See “Application Hot-Key” on page 2 - 8 for 

configuration instructions.

Modem Country Selection

Go to the Phone and Modem Options control panel
(Hardware and Sound) and make sure the modem
country selection is appropriate for you.
4 - 6 Driver Installation
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Wireless LAN Module
See the introduction in “Wireless LAN Module” on
page 7 - 2, and check the installation procedure.

PC Camera Module
See the introduction in “Bluetooth Module” on
page 7 - 7, and check the installation procedure.
Driver Installation 4 - 7
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Chapter 5: BIOS Utilities
Overview
This chapter gives a brief introduction to the computer’s built-in software: 

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility 
If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

BIOS Settings 
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Set-
up Defaults with <F9>.
Overview 5 - 1
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The Power-On Self Test (POST)
Each time you turn on the computer, the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.

POST Screen

1.BIOS information
2.CPU type 
3.Memory status
4.Enter Setup prompt

appears only during
POST

Note: The POST screen
as pictured right is for
guideline purposes only.
The POST screen on
your computer may ap-
pear slightly different. If
you disable the Boot-
time Diagnostic Screen,
the POST screen will not
appear.

Figure 5 - 1
POST Screen

Phoenix TrustedCore(tm) NB
Copyright 1985-2004 Phoenix Technologies Ltd.
All Rights Reserved
Bios Ver: M5x0N - D.00.01
KBC Ver: 1.00.E4

CPU = 1 Processors Detected, Cores per Processor - 2
Genuine Intel(R) CPU 1300 @ 1.66GHz
256M System RAM Passed
2048K Cache SRAM Passed
System BIOS shadowed
Video BIOS shadowed
ATAPI CD-ROM: PIONEER DVD-RW DVR-K16RA
Fixed Disk 0: FUJITSU MHT2060BH
Mouse intialized

Press <F2> to enter SETUP

1

2

3

4

5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup 

Press F1 to see if the boot process can continue. It may work, without the correct
configuration. 

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.
The Power-On Self Test (POST) 5 - 3
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The Setup Program
The Phoenix Setup program tells the system how to configure itself and manage ba-
sic features and subsystems (e.g. port configuration).

Entering Setup
To enter Setup, turn on the computer and press F2 during the POST. The prompt
(Press F2 to Enter Setup) seen on page 5 - 2 is usually present for a few seconds
after you turn on the system. If you get a “Keyboard Error”, (usually because you
pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.
5 - 4 The Setup Program
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Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with five (5) menu headings. When you
select a heading, a new screen appears. Scroll through the features listed on each
screen to make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the
screen. If these tools are confusing, press F1 to call up a General Help screen, and
then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.

Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.
The Setup Program 5 - 5
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Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

Figure 5 - 2
Main Menu

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

<Tab>, <Shift Tab>, or
<Enter> selects field.

Main

System Time: [22:12:05]
System Date: [01/15/2007]

�IDE Channel 0 Master [TSSTcorpCD/DVDW TS L632D-]
�SATA Port 1 [TOSHIBA MK6034GSX-(S1)]

System Memory 640 KB
Extended Memory 1014 MB
5 - 6 Main Menu
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IDE Channel 0 Master/SATA Port 1 (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of either a CD Device
or HDD on the computer’s IDE Channel 0/SATA port 1. Use the Auto (Type:) set-
ting to have the items configured automatically for you.

System/Extended Memory (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.
Main Menu 5 - 7
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Advanced Menu

Installed O/S: (Advanced Menu)
This setting tells the computer what kind of operating system you’re using.

Reset Configuration Data: (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have in-
stalled a new add-on which has reconfigured the system, resulting in such a serious
system conflict that the operating system is unable to boot.

Figure 5 - 3
Advanced Menu

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Select the operating
system installed
on your system which
you will use most
commonly.

Note: An incorrect
setting can cause
some operating
systems to display
unexpected behavior.

Advanced

�Installed O/S: [WinXP]
Reset Configuration Data: [No]
Large Disk Access Mode: [DOS]
Local Bus IDE Adapter: [Primary]

Legacy USB Support: [Enabled]
Boot-time Diagnostic Screen: [Enabled]
POST Beep Sound: [Disabled]
Total Graphics Memory: [224MB]
5 - 8 Advanced Menu
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Large Disk Access Mode: (Advanced Menu)
Select “Other” if you are using systems such as Novell, UNIX etc. Select “DOS” (de-
fault) if you are using Windows.

Local Bus IDE adapter: (Advanced Menu)
This item allows you to configure the IDE bus which controls the hard disk and op-
tical devices. It is set to “Primary” by default.

Legacy USB Support: (Advanced Menu)
Use this menu item to enable/disable the support for Legacy Universal Serial Bus.

Boot-time Diagnostic Screen: (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen.

POST Beep Sound (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Total Graphics Memory: (Advanced Menu)
Use this menu item to set the amount of system memory to be allocated for use by
the internal graphics device. The default memory size allocated is 224MB, and this
may be adjusted to 64MB or 128MB (by pressing the spacebar to adjust) if required.
Advanced Menu 5 - 9
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Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Setup utility. This will not affect access to
the computer OS, (only the Setup utility) unless you choose to set a Password on
Boot (see over).

Security Menu

The changes you make
here affect the access to
the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Figure 5 - 4
Security Menu

PhoenixBIOS Setup Utility

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Supervisor Password
controls access to the
setup utility.

Set Supervisor Password [EEnter]

Password on boot: [Disabled]
Fixed disk boot sector: [Normal]

Main Advanced Security Boot Exit
5 - 10 Security Menu
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Password on boot: (Security Menu)
Specify whether or not a password should be entered to boot the computer. If “En-
abled” is selected, only users who enter a correct password can boot the system (see
the warning in the sidebar). The default setting is “Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Fixed disk boot sector: (Security Menu)
If you choose “Write Protect” this will protect against viruses being written to the
hard disk boot sector (this is not a substitute for installing an anti-virus program - see
“Viruses” on page 8 - 4).

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
Security Menu 5 - 11
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Boot Menu

When you turn the computer on it will look for an operating system (e.g. Win-
dowsXP) from the devices listed in this menu, and in this priority order. If it cannot
find the operating system on that device, it will try to load it from the next device in
the order specified in the Boot priority order. Item specific help on the right is
available to help you move devices up and down the order.

Figure 5 - 5
Boot Menu

PhoenixBIOS Setup Utility

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Keys used to view or
configure devices:
Up and Down arrows
select a device.
<+> and <-> moves
the device up or down.
<f> and <r> specifies
the device fixed or
removable.
<x> exclude or include
the device to boot.
<Shift + 1> enables or
disables a device.
<1 - 4> Loads default
boot sequence.

Boot priority order:
1: USB FDC:
2: USB HDD:
3: IDE CD: TSSTcorpCD/DVDW TS-L632D-
4: IDE HDD: TOSHIBA MK6034GSX-(S1)
5: PCI BEV: Realtek Boot Agent
6:
7:
8:

Excluded from boot order:
: USB KEY:
: USB CDROM:
: USB ZIP:
: USB LS120:
: PCI SCSI:
: Other USB:
: PCI:

Main Advanced Security Boot Exit
5 - 12 Boot Menu
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Exit Menu

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

Figure 5 - 6
Exit Menu

PhoenixBIOS Setup Utility

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Exit System Setup and
save your changes to
CMOS.

Exit Saving Changes
Exit Discarding Changes
Load Setup Defaults
Discard Changes
Save Changes

Main Advanced Security Boot Exit
Exit Menu 5 - 13
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Chapter 6: Upgrading The Computer
Overview
This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problems you can con-
tact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

• Removing the Battery
• Upgrading the Hard Disk Drive
• Upgrading the Optical (CD/DVD) Device
• Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Overview 6 - 1
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When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.

You should not perform any of these upgrades if:

• Your system is still under warranty or a service contract
• You don’t have all the necessary equipment 
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.
6 - 2 Overview
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Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery.
1. Turn the computer off, and turn it over.
2. Slide the latch  in the direction of the arrow, and hold it in place.
3. Slide the battery in the direction of the arrow .

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

1
2

2

1

11

Figure 6 - 1
Battery Latch
Removing the Battery 6 - 3
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4. Lift the battery up and out in the direction of the arrow .

5. Insert the battery by pushing it straight down into the battery bay (it will only fit one 
way, don’t force it). 

6. Make sure the battery is sitting flat in the slot, and then slide the battery in the 
direction of the arrow  until the lock clicks into place.

3

3
Figure 6 - 2

Battery Removal

Figure 6 - 3
Battery Insertion

4

4

6 - 4 Removing the Battery
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Upgrading the Hard Disk Drive
The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard
disk drives with a height of 9.5mm (h) (see “Storage” on page C - 3). Follow your
operating system’s installation instructions, and install all necessary drivers and util-
ities (as outlined in “Driver Installation” on page 4 - 2), when setting up a new hard
disk.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screw  Model A OR screws  -  

Model B.

HDD System 
Warning

New HDD’s are blank. Be-
fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.
You have all the CD-ROMs
and FDDs required to in-
stall your operating system
and programs.
If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

Figure 6 - 4
Hard Disk Bay & 

Screw

1 2 3

32

Model A Model B

1
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For Model A computers (see overleaf for Model B):

3. Slide the hard disk and cover assembly in the direction of arrow .
4. Lift the hard disk and cover assembly up in the direction of arrow .
5. Remove the hard disk and cover assembly .
6. Remove the 4 screws to release the hard disk from the assembly cover, and 

reverse the process to install any new hard disk.

4

Figure 6 - 5
HDD & Cover 

Assembly 
Removal 
(Model A 

Computers Only)

5
6

4

5 6

Model A

Model A

Model A
6 - 6 Upgrading the Hard Disk Drive
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For Model B computers:

7. Pull the tab to slide the hard disk and case assembly in the direction of arrow .
8. Lift the hard disk and case assembly out of the bay in the direction of arrow .
9. Remove screws  -  to release the hard disk  from the case , and 

reverse the process to install any new hard disk.

7
8

9 10 11 12

Figure 6 - 6
HDD & Case 

Assembly 
Removal 
(Model B 

Computers Only)

7

Model B 10

11

12
 

8

9
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Upgrading the Optical (CD/DVD) Device
1. Turn off the computer, and turn it over and remove the battery.
2. Locate the module bay cover and remove screws  -  (Model A)/  -  

(Model B).
3. Remove the bay cover 
4. Use a screwdriver to carefully push out the optical device at point .
5. Reverse the process to install the new device.

Figure 6 - 7
Removing the CD/

DVD Device

1 7 1 5

8
9

3 42

5
1

67

Model A Model B 1
2 3

4
5

8
99
6 - 8 Upgrading the Optical (CD/DVD) Device
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Upgrading the System Memory (RAM)
The computer has two memory sockets for 200 pin Small Outline Dual In-line (SO-
DIMM) DDRII (DDR2) type memory modules (see “Memory” on page C - 2 for
details of supported module types). 

The total memory size is automatically detected by the POST routine once you turn
on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the module bay cover and remove screws  -  (Model A)/  -  

(Model B).
1 7 1 5

3 42

5
1

67

Model A Model B 1
2 3

4
5

Figure 6 - 8
Module Bay 

Screws
Upgrading the System Memory (RAM) 6 - 9
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3. Remove the bay cover .

4. Gently pull the two release latches on the sides of the memory socket in the 
direction indicated by the arrows (  & ) in Figure 6 - 10.

8

8

Figure 6 - 9
RAM Cover 
Removed

9 10

9

10

Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s
performance.

Figure 6 - 10
RAM Module 

Removal
6 - 10 Upgrading the System Memory (RAM)
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5. The RAM module will  pop-up, and you can remove it.

6. Pull the latches to release the second module if necessary.
7. Insert a new module holding it at about a 30° angle and fit the connectors firmly 

into the memory slot.
8. The module’s pin alignment will allow it to only fit one way. Make sure the module 

is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit 
without much pressure.

9. Press the module in and down towards the mainboard until the slot levers click into 
place to secure the module.

10. Replace the memory socket cover and the screw.
11. Restart the computer to allow the BIOS to register the new memory configuration 

as it starts up.

11

11

Figure 6 - 11
RAM Removal
Upgrading the System Memory (RAM) 6 - 11
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Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.

Warranty

The CPU is not a user
serviceable part. Open-
ing this compartment, or
accessing the CPU in
any way, may violate
your warranty.

Unauthorized tampering
with the HDD may also
violate your warranty.
6 - 12
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Chapter 7: Modules & Options
Overview
This chapter contains information on the following modules, which may come with
your computer, depending on the configuration purchased. If you are unsure please
contact your service representative.

• Wireless LAN Module
• Bluetooth Module
• PC Camera Module

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are
using the computer
aboard aircraft. 
Overview 7 - 1
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Wireless LAN Module
Before installing the Intel PRO/Wireless 3945ABG (802.11a/b/g) PCIe WLAN
driver, make sure that the optional Wireless LAN module is on. Use the Fn + F11
key combination (see “Function Keys” on page 1 - 11) to toggle power to the
WLAN module (the  LED will be green when the module is powered on). Make
sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3. 

Intel WLAN Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & 

Utilities + User’s Manual CD-ROM into the CD/DVD drive. 
2. Click Install Option Drivers (button). 
3. Click 1.Install WLAN Driver > Yes.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the indicator to see if
the module is powered on
or not (see Table 1 - 4, on
page 1 - 9/Table 1 - 6, on
page 1 - 11).
7 - 2 Wireless LAN Module
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Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon , and then click Connect to a network (or right-
click the icon , and then click Connect to a network).

2. In the Show list, click to choose Wireless from the drop-down menu.
3. A list of currently available networks will appear.

Figure 7 - 1
Taskbar Menus

Network and 
Sharing Center

You can also use the
Network and Sharing
Center control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure 7 - 2
Connect to a 

Network

Click icon Right-click icon
Wireless LAN Module 7 - 3
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4. Click a network, and then click Connect.
5. If you do not see a network you want to connect to, click Set up a connection or 

network (a list of options will appear allowing manual searching, and creating a 
new network).

6. Move the cursor over the taskbar icon  to see the connection status (see below).

Figure 7 - 3
Connecting

Figure 7 - 4
Connection Status
7 - 4 Wireless LAN Module
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7. To disconnect from the wireless network you can click the taskbar wireless icon 
, and then select Connect or disconnect to access the network menu, and 

click Disconnect (or right-click the icon , and then click Disconnect from).
Security Enabled 

Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure net-
works may allow unautho-
rized access to your
computer, documents, web-
sites and files etc.

Figure 7 - 5
Disconnecting

Click icon

Right-click icon
Wireless LAN Module 7 - 5
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Windows Mobility Center
The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:
1. Click Start, and click Control Panel (or point to Settings and click Control 

Panel).
2. Double-click Windows Mobility Center (Mobile PC).
3. Click the button to Turn wireless off/on, or click the icon  to access the network 

menu.

Figure 7 - 6
Windows Mobility 

Center
7 - 6 Wireless LAN Module
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Bluetooth Module
The optional Bluetooth module allows you to connect your computer to Bluetooth
enabled devices such as other computers, desktop computers, mobile phones, print-
ers, digital cameras, PDAs, headsets etc. using a short-range radio frequency.

Use the Fn + F12 key combination (see “Function Keys” on page 1 - 11) to toggle
power to the Bluetooth module (the  LED will be orange when the module is
powered on). Configure the Bluetooth module from the Windows Vista control pan-
el as per the instructions overleaf. 

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the indicator to see if
the module is powered on
or not (see Table 1 - 4, on
page 1 - 9/Table 1 - 6, on
page 1 - 11).
Bluetooth Module 7 - 7
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Bluetooth Configuration in Windows Vista
Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

Turn the Bluetooth Module on
1. Press the Fn + F12 key combination to power on the Bluetooth module. 
2. A Bluetooth icon  will appear in the taskbar (see sidebar).
3. You can then do any of the following to access the Bluetooth Devices control 

panel.

• Double-click the icon  to access the Bluetooth Devices control panel.
• Click Start, and click Control Panel (or point to Settings and click Control Panel), and then 

click Bluetooth Devices (Hardware and Sound).
• Click/Right-click the icon  and choose an option from the menu.

Bluetooth Taskbar 
Icon

If you cannot see the
Bluetooth icon in the
taskbar, access the
Bluetooth Devices
control panel. Click Op-
tions (tab), and make
sure that Show Blue-
tooth icon in the notifi-
cation area check box
(Connections) has a
tick inside it.

Figure 7 - 7
Bluetooth Devices & 

Click Icon Menu
7 - 8 Bluetooth Module
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Install the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click Options (tab), and make sure that Allow Bluetooth devices to connect to 

this computer check box (Connections) has a tick inside it.
3. Click Devices (tab), and then click Add.
4. The Add Bluetooth Device Wizard will appear.
5. Click to select “My device is set up and ready to be found”, and then click Next.

6. The Wizard will then search for any available Bluetooth devices within range.
7. Select the device you which to communicate with, and click Next.
8. Select an appropriate passkey option and click Next.

9. Click Finish.

Figure 7 - 8
Add Bluetooth 
Device Wizard

Figure 7 - 9
Passkey Option
Bluetooth Module 7 - 9
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To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:

• Change the name of the device (click General, type a new name and click OK).
• Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable To Bluetooth Devices
1. Access the Bluetooth Devices control panel.
2. Click Options, and make sure that Allow Bluetooth devices to find this 

computer check box (Discovery) has a tick inside it.
3. Make sure that Alert me when a new Bluetooth device wants to connect check 

box (Connections) has a tick inside it, if you want to be notified when a Bluetooth 
device wants to connect.

Figure 7 - 10
Bluetooth Devices 

Options
7 - 10 Bluetooth Module
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PC Camera Module
Before installing the PC Camera driver, make sure that the optional PC Camera is
on. Use the Fn + F10 key combination (see “Function Keys” on page 1 - 11) to
toggle power to the PC Camera module. Make sure you install the drivers in the
order indicated in Table 4 - 1, on page 4 - 3. 

PC Camera Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & 

Utilities + User’s Manual CD-ROM into the CD/DVD drive. 
2. Click Install Option Drivers (button). 
3. Click 2.Install Camera Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish to restart the computer.
7. Run the BisonCap application program from the BisonCam shortcut on the 

desktop, or from the BisonCam item in the Start > Programs/All Pro-
grams menu (if the hardware is turned off use the Fn + F10 key combina-
tion to turn it on again).

Latest PC Camera 
Driver Information

Check the PC Camera
CD, and any accompa-
nying insert pages, for
the latest updated infor-
mation on the PC Cam-
era driver, which may
override the information
provided here.
PC Camera Module 7 - 11
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control 
Panel).

2. Click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is 

not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to 

the level required.
7. Click OK and close the control panels.
8. Run the BisonCap application program from the Start > Programs/All Programs 

> BisonCam menu.
9. Go to the Devices menu heading and select Microphone (Realtek).... (it should 

have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick 

alongside it).
7 - 12 PC Camera Module
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Figure 7 - 11
Audio Setup for PC 

Camera

Right-click
PC Camera Module 7 - 13
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BisonCap
BisonCap is a video viewer useful for general purpose video viewing and testing,
and can capture video files to .avi format.

1. Run the BisonCap program from the Start > Programs/All Programs > Bison-
Cam menu (it is recommended that you set the capture file before the capture 
process - see Set Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera 
Audio Setup” on page 7 - 12) and select Start Capture.

3. On the first run of the program (if you have not set the captured file) you will be 
asked to choose a file name and size (see the sidebar - Pre-Allocating File 
Space) for the captured file. Click Start Capture again.

4. Click OK to start capturing the video, and press Esc to stop the capture.
5. If you wish to, you may go to the File menu and select Save Captured Video 

As..., choose a file name and location, and then click Open (you can view the file 
using the Windows Media Player).

Set Capture File
In the BisonCap program you will only be asked to set the capture file name on the
first run of the program. When you run the program the next time the file will auto-
matically be overwritten with the newly captured file. To avoid overwriting files you
can go to the Set Capture File.. option in the File menu, and set the file name and
location before capture. Set the name and location then click Open (you can choose
Cancel to ignore the file size if prompted).

Pre-Allocating File 
Space

You may pre-allocate
the file size for the cap-
ture file in the BisonCap
program. You can
choose to ignore this by
clicking Cancel.

Pre-allocating space on
the hard disk can im-
prove the capture quali-
ty (particularly of large
capture files), by reduc-
ing the amount of work
the hard disk has to do
in finding space for the
video data as it is being
captured.
7 - 14 PC Camera Module



Modules & Options

7

Eliminating Screen Flicker
If you find that the video screen in the BisonCap program is flickering, you can try
to adjust the setting in the Video Capture Filter options.

1. Run the BisonCap program.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Figure 7 - 12
Video Capture Filter
PC Camera Module 7 - 15
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Chapter 8: Troubleshooting
Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.
Overview 8 - 1



Troubleshooting

8

Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, 
make sure it is actually working. Check the LED Power & Communication Indicators (see “LED Indica-
tors” on page 1 - 9) to see the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Configuring the Power Buttons” on page 3 - 8), the Fn + F4 key combi-
nation, or power button to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness.

• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive 
when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the 
disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
8 - 2 Basic Hints and Tips
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. 

Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with 
your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if 
you choose to use a Supervisor password for the BIOS (see “Security Menu” on page 5 - 10).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).

Warranty
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
Backup and General Maintenance 8 - 3



Troubleshooting

8

Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses 

to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm 
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the 
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic 
information which allows you to startup your computer) handy. You may refer to your OS’s documentation 
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at 
least instructions on how to make one).
8 - 4 Viruses
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are 

doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what 
you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s 
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by 
the installation of new hardware and/or software. Always refer to the documentation of any new hardware 
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need 
to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are 
usually available to download from vendor’s websites).
Upgrading and Adding New Hardware/Software 8 - 5
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• Thoroughly check any recent changes you made to your system as these changes may affect one or more 
system components, or software programs. If possible, go back and undo the change you just made and see 
if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may 
be found; Example - if your computer has many devices plugged into its ports, and a number of programs 
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and 
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and 
removing devices and restarting where necessary) will often find the source of a problem, although this may 
be time consuming.
8 - 6 Upgrading and Adding New Hardware/Software
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Power

Problem Possible Cause - Solution

You turned on the power
but it doesn’t work.

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is present and
seated properly (the design of the battery only allows it to go in one way). Make sure there’s
nothing interfering with the battery contacts.

The battery LED power
indicator , is blinking
orange.

Low Battery. Plug in the DC power source. If the computer doesn’t start up immediately, turn it off
then on again.

You are losing battery
power too quickly.

The system is using too much power. Check the settings of any active power plan (see “Power
Plans” on page 3 - 4). You may also be using an PC Card/ExpressCard device/USB device/
external device that is drawing a lot of power.

Actual battery operating
time is shorter than
expected.

The battery has not been fully discharged before being recharged. Make sure the battery is fully
discharged and recharge it completely before reusing (see “Battery Information” on page 3 -
9).

Check the settings of any active power plan (see “Power Plans” on page 3 - 4).

A peripheral device/USB device/PC Card is consuming a lot of power. Turn off/remove the
unused device to save power.
Power 8 - 7
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The computer feels too
hot.

Make sure the computer is properly ventilated and the Vent/Fan intakes are not blocked. If this
doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the
computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 15). Make sure
you’re using the correct adapter. 

Make sure that your notebook is completely powered off before putting it into a travel bag (or any
such container). Putting a notebook which is powered on in a travel bag may cause the Vent/Fan
intakes to be blocked.

Problem Possible Cause - Solution
8 - 8 Power
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Display

Problem Possible Cause - Solution

Nothing appears on
screen.

The system is in a power saving mode. Toggle the Fn + F4 (see “Configuring the Power
Buttons” on page 3 - 8) sleep/resume key combination.

The screen controls need to be adjusted. Toggle the screen control key combinations Fn + F8/F9.
If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should
also check the monitor’s own brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key combination, Fn + F7. If
an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the
external monitor I have
plugged in and powered
on.

You haven’t installed the video driver and configured it appropriately from the Control Panel. See
“Intel Video Driver Controls” on page B - 1 for instructions on installing and configuring the
video driver.
Display 8 - 9
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Boot Password

Problem Possible Cause - Solution

You forget the boot
password.

If you forget the password, you may have to discharge the battery of the CMOS. Contact your
service representative for help.

Password Warning
If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
8 - 10 Boot Password
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Audio & CD Device

Problem Possible Cause - Solution

The sound cannot be
heard or the volume is
very low.

The volume might be set too low. Check the volume control in the Volume Control Panel in the
Windows taskbar, or use the key combination Fn + F5 and F6 (see “Audio Features” on page 2
- 10) to adjust.

The compact disc cannot
be read.

The compact disc is dirty. Clean it with a CD-ROM cleaner kit.

The compact disc tray
will not open when there
is a disc in the tray.

The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject
hole (see “Loading Discs” on page 2 - 3).

The DVD regional codes
can no longer be
changed.

The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5.
Audio & CD Device 8 - 11
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Keyboard

Problem Possible Cause - Solution

Unwelcome numbers
appear when typing.

If the LED  is lit, then Num Lock is turned ON. (see “LED Indicators” on page 1 - 9).

Other Keyboards
If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not
work.
8 - 12 Keyboard
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Operation
Problem Possible Cause - Solution

The system freezes or
the screen goes dark.

The system’s power saving features have timed-out. Use the AC/DC adapter, press the sleep (Fn
+ F4) key combination, or press the power button if no LEDs are lit.
Operation 8 - 13
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Modules
Problem Possible Cause - Solution

The Wireless LAN/
Bluetooth modules
cannot be detected.

The modules are off. Check the LED indicator  to see if the WLAN/Bluetooth module is on or
off (see “LED Indicators” on page 1 - 9). If the LED indicator is off, then press the Fn + F11
(WLAN) or Fn + F12 (Bluetooth) key combination(s) in order to enable the modules (see
“Function Keys” on page 1 - 11).

The PC Camera module
cannot be detected.

The module is off. Press the Fn + F10 key combination in order to enable the module (see
“Function Keys” on page 1 - 11). Run the BisonCap program (see “PC Camera Module” on
page 7 - 11) to view the camera picture.

The Wireless LAN/
Bluetooth/ PC Camera
modules cannot be
configured.

The driver(s) for the module(s) have not been installed. Make sure you have installed the driver
for the appropriate module (see the instructions for the appropriate module in “Modules &
Options” on page 7 - 1).
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Appendix A: Interface (Ports & Jacks)
Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.
Interface (Ports & Jacks) A - 1
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Notebook Ports and Jacks

Item Description

Built-In Microphone The built-in microphone allows you to record on your computer 

Card Reader Port The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor (VGA) 
Port

This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or
simultaneous display on the LCD and external monitor/FPD (see “Display Devices” on page B -
5).

Headphone-Out Jack Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.

Line-In Jack The Line-In jack allows you to play audio sources through the computer’s speakers.
A - 2 Interface (Ports & Jacks)



Interface (Ports & Jacks)

A

Microphone-In Jack Plug an external microphone in to this jack to record on your computer.

Mini-IEEE 1394 Port This port allows a high-speed connection to various peripheral devices, e.g. external disk drives
and digital cameras (see note below).

RJ-11 Phone Jack This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11
telephone connection. 
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

Item Description

Mini-IEEE 1394 Port
The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices.
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S/PDIF-Out Jack This S/PDIF (Sony/Philips Digital Interface Format) Out Jack allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

S-Video-Out Jack Connect your television to your computer and view DVDs, VCDs or anything else your computer
can display. You will need an S-Video cable to make the connection. Enable this jack from the
video driver controls.

USB 2.0/1.1 Ports These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into
the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
comes with the device).

Item Description
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Appendix B: Intel Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 15.

Intel Video Driver Installation
Make sure you install all the drivers in the order indicated in Table 4 - 1, on page 4
- 4. Instructions for installing the video driver are repeated below.

Video (VGA)
1. Click 2.Install Video Driver > Yes.
2. To continue click Next > Yes > Next.
3. Click Finish to restart the computer.

Dynamic Video Memory Technology
Intel® DVMT automatically and dynamically allocates as much (up to 128MB) sys-
tem memory (RAM) as needed to the video system (the video driver must be in-
stalled). DVMT returns whatever memory is no longer needed to the operating
system. To adjust the total video memory used by the computer (Pre-Allocated
+ Fixed + DVMT) see “Total Graphics Memory: (Advanced Menu)” on page 5 - 9.

DVMT Notes

DVMT is not local video
memory.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory indi-
cated.
Intel Video Driver Installation B - 1
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Intel Graphics Properties
More advanced video configuration options are provided by the Intel(R) Graphics
Media Accelerator Driver for Mobile.

1. Open the Display Settings control panel (see “Video Features” on page 1 - 15) 
and click Advanced Settings (button).

2. Click the Intel(R)... tab and click Graphics Properties (button).

Taskbar Icon

The Intel GMA control
panel can also be ac-
cessed by clicking the
icon  in the taskbar
and selecting Graphics
Properties from the
menu.

If you cannot see the
tray icon click the “Show
Tray Icon” tickbox in the
Intel(R) Graphics Me-
dia Accelerator for Mo-
bile tab.

Figure B - 1
Intel Graphics 

Properties
B - 2 Intel Graphics Properties
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You may make changes to the devices, color, schemes, Hot Keys etc. by clicking
the appropriate menu item or button. Click Information (button) to obtain useful in-
formation about the graphics properties of the computer, and see the Support tab in
Information to get weblinks to the latest information on the Intel Website.

Figure B - 2
Intel Graphics Media 
Accelerator Driver 

for mobile
(Control Panel Tabs)

Help Menus

Right-click on many of
the items in the tabs to
bring up the “What’s
This?” button.

Click the “What’s This?”
button to bring up the
help menu.

Multiple Display

At least one other dis-
play must be attached in
order to view Multiple
Display options.
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Scheme Options
Use Scheme Options to configure quick settings for applications which require spe-
cific resolution and color settings in order to run properly e.g. games, multimedia
programs. To set the scheme options:

1. Open the Display Settings control panel and click Advanced Settings (button).
2. Click the Intel(R)... tab and click Graphics Properties (button).
3. Configure your display configuration, resolution etc. as per your requirements.

from Display Settings.
4. Click on Scheme Options (button).
5. Type a name for the scheme then click OK.
6. If you want to automatically launch an application when running the scheme click

on Browse (button).
7. Browse to the executable file for the application you want to set the scheme for

(see sidebar), and click Open to select it.
8. Click Save to save the settings (you can click in the "Restore the display

settings after exiting this application" box to return to your original settings
when you exit the program).

9. Click OK to exit the window.
10. You can run the scheme by clicking the taskbar icon  and selecting the scheme

from Select Scheme.

Application.exe

You will need to locate
the actual application
executable (.exe) file,
not just the shortcut. To
find the application right-
click its shortcut on the
desktop click Proper-
ties. Click the Shortcut
(tab) and see where the
executable file is located
by clicking the Find Tar-
get (button). Note the lo-
cation and you will then
be able to browse to this
file.

Figure B - 3
Select Scheme
B - 4 Intel Graphics Properties
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Display Devices
Besides the built-in LCD, you can also use an external monitor/flat panel display or
TV as your display device. The following are the display options:

1. The built-in LCD.
2. An external monitor connected to the external monitor port.
3. A flat panel display connected to the external monitor port.
4. A TV connected to the S-Video-Out Jack.

Function Key 
Combination

You can use the Fn + F7
key combination to tog-
gle through the display
options:

• Notebook Only
• External Display Only
• Notebook + External 

Display

Make sure you give the
displays enough time to
refresh.

Switching Modes When Using the Power DVD Application

Switch display modes before playing any DVD in the Power DVD Application it is not be
possible to switch display modes while a DVD is playing (you will be required to stop the
DVD playing, switch display modes, then start the DVD playing again).
Display Devices B - 5
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Attaching Other Displays
If you prefer to use a monitor or flat panel display, connect it to the external monitor
port at the rear of the computer.

Windows Vista
1. Attach your external display to the external monitor port (or TV to the S-Video-Out 

Jack), and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click on any of the buttons to configure the displays to your preference, or click
Display Settings to access the control panel.

Figure B - 4
 New Display 

Detected
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Intel® GMA Driver for Mobile
1. Go to the Intel Graphics Properties control panel (see “Intel Graphics Proper-

ties” on page B - 2) and click Display Devices.
2. Click to choose the display option from the Multiple Display menu.
3. Click Apply (and OK to confirm the settings change) and OK (button).

Multiple Display

At least one other dis-
play must be attached in
order to view Multiple
Display options.

Only attached display
types (e.g. Monitor or
Television) will be dis-
played as options in the
Primary/Secondary De-
vice drop down menus.

Figure B - 5
 Display Devices
Attaching Other Displays B - 7
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Display Modes
Single Display
Only one of your attached displays is used.

Intel(R) Dual Display Clone (mirrored)
This mode will drive multiple displays with the same content. Each device may be
configured independently for different resolutions, refresh rates, color quality etc.
Use this feature to display the screen through a projector for a presentation.

Extended Desktop (extended)
This mode allows a desktop to span multiple displays and acts as a large workspace.
This creates a lot more screen area for display. Use the Display Properties control
panel to drag the monitors to match the physical arrangement you wish to use, or you
may also use the Extended Desktop Settings control panel tab in Graphics Prop-
erties to configure the relative size and position.
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To Enable Intel(R) Dual Display Clone
1. Attach your external monitor to the external monitor port (or TV to the S-Video-Out 

Jack), and turn it on.
2. Go to the Intel Graphics Properties control panel (see “Intel Graphics

Properties” on page B - 2) and click Display Devices.
3. Click to choose Intel(R) Dual Display Clone (Multiple Display).
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

Figure B - 6
 Display Devices & 

Settings
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To Enable Extended Desktop
1. Attach your external monitor to the external monitor port (or TV to the S-Video-Out 

Jack), and turn it on.
2. Go to the Intel Graphics Properties control panel (see “Intel Graphics

Properties” on page B - 2) and click Display Devices.
3. Click to choose Extended Desktop (Multiple Display).
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

 Display Settings 
Extended Desktop 

You can have different
Colors, Screen Area
and Monitor Refresh
Rates for each display
device provided your
monitor can support
them.

You can drag the moni-
tor icons to match the
physical layout of your
displays. Icons and pro-
grams may also be
dragged between the
displays.

Figure B - 7
Extended Desktop 

Mode

Click the appropriate moni-
tor icon and drag it to match
the physical arrangement
you wish to use (e.g. the
secondary display may be
extended left/right/above/
below  the primary display).

Click Display Settings to
make any adjustments re-
quired.
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Using Windows Vista to Enable Extended Mode
1. Attach your external display to the external monitor port (or TV to the S-Video-Out 

Jack), and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click to select Show different parts of my desktop on each display (extended).
4. Click Right or Left under Extend your desktop.
5. Click Apply > OK.

 Display Settings 
Extended Desktop 

Use the control panel to
drag the monitors to
match the physical ar-
rangement you wish to
use. 

You can drag any icons
or windows across to ei-
ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the
other display.

Figure B - 8
Display Properties 

(Extended Desktop)
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Using Display Settings to Enable Extended Mode
1. Attach your external display to the external monitor port (or TV to the S-Video-Out 

Jack), and turn it on.
2. Open the Display Settings control panel (see “Video Features” on page 1 - 15).
3. Click the monitor icon (e.g. ), and make sure you have checked “Extend my

Windows desktop onto this monitor.” and click Apply.

Figure B - 9
Display Properties 

(Extended Desktop)

2

Click the appropriate monitor icon
(e.g. ) to be able to select the op-
tion to extend the desktop on to it.

In this example the Primary Display
 is on the left, the Secondary Dis-

play  is on the right.

2

1
2
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TV Settings
If you are using a TV as a display device adjust the display settings as follows:

1. Use an S-Video cable to connect your TV to the S-Video-Out Jack and turn it on.
2. Go to the Intel Graphics Properties control panel (see “Intel Graphics

Properties” on page B - 2) and click Display Devices.
3. Click to choose  the Multiple Display option.
4. Choose the television as one of your display devices (Primary or Secondary).
5. Click Apply, and OK to confirm the settings change.

Function Key 
Combination

You can use the Fn + F7
key combination to tog-
gle through the display
options:

• Notebook Only
• External Display Only
• Notebook + External 

Display

Make sure you give the
displays enough time to
refresh.

Figure B - 10 
Display Devices 

with TV
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6. Click Display Settings to adjust the settings for the television.
7. Choose the appropriate TV system from Video Standard dropbox.
8. Click the TV Settings (button) to make any video adjustments for the television.

Figure B - 11
TV Settings
B - 14 TV Settings
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Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed or updated due to the manufacturer's release schedule. Check with your
service center for details.
Specifications C - 1
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Feature Specification

Processor Intel® Core™ Duo Processor
(478-pin) Micro-FC-PGA Package
T2300/ T2400/ T2500/ T2600/ T2700 

65nm (65 Nanometer) Process Technology
2MB On-die L2 Cache & 667MHz FSB
1.66/ 1.83/ 2.0/ 2.16/ 2.33 GHz

Intel® Core™ Solo Processor
(478-pin) Micro-FC-PGA Package
T1300/ T1400

65nm (65 Nanometer) Process Technology
2MB On-die L2 Cache & 667MHz FSB
1.66/ 1.83 GHz

Intel® Celeron® M Processor
(478-pin) Micro-FCPGA Package
410/ 420/ 430/ 440/ 450

65nm (65 Nanometer) Process Technology
1MB On-die L2 Cache & 533MHz FSB
1.46/ 1.60/ 1.73/ 1.86/ 2.0 GHz

Intel® Core™2 Duo Processor
(478-pin) Micro-FC-PGA Package
T7200/ T7400/ T7600

65nm (65 Nanometer) Process Technology
4MB On-die L2 Cache & 667MHz FSB
2.0/ 2.16/ 2.33 GHz

Intel® Core™2 Duo Processor
(478-pin) Micro-FC-PGA Package
T5500/ T5600

65nm (65 Nanometer) Process Technology
2MB On-die L2 Cache & 667MHz FSB
1.66/ 1.83 GHz

Core Logic Intel 945GM + ICH7-M

Memory Two 200 Pin SO-DIMM Sockets Supporting DDRII (DDR2) 533 / 667 MHz
128-bit Wide DDRII (DDR2) Data Channel
Memory Expandable up to 2GB (256/ 512/ 1024 MB DDRII Modules)

Security Security (Kensington® Type) Lock Slot BIOS Password
C - 2 Specifications
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BIOS One 4Mb Flash ROM Phoenix™ BIOS, Plug and Play

LCD Model A Computers:
15.0" XGA (1024*768) Flat Panel TFT

OR
15.0" SXGA+ (1400*1050) Flat Panel TFT

Model B Computers:
14.0" WXGA (1280*768) Flat Panel TFT

OR
14.1" WXGA (1440 *900) Flat Panel TFT

Video Adapter Intel 945GM Integration
Supports Dynamic Video Memory Technology DVMT 3.0 - Up to 128MB of Video Memory (dynamically 
allocated from system memory where needed)
Supports Analog Monitor Pixel Resolution up to 1600 * 1200 at 85Hz
Supports DirectX 9.1 3D Graphics Engine Accelerator

Storage One Changeable 12.7mm(h) Optical Device (CD/DVD) Type Drive (see “Optional” on page C - 5 for 
drive options)
Easy Changeable 2.5" 9.5 mm (h) HDD with SATA (Serial) Interface

Audio Integrated AZALIA Compliant Interface (HDA)
3D Stereo Enhanced Sound System
Sound-Blaster PRO™ Compatible
2 * Built-In Speakers
Built-In Microphone

Keyboard & 
Pointing Device

Winkey Keyboard Built-In TouchPad with Scrolling Function

Feature Specification
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Interface Three USB 2.0 Ports
One External Monitor Port
One Headphone-Out Jack
One Microphone-In Jack
One Line-In Jack
One S/PDIF Output Jack

One RJ-11 Jack for Plug & Play Fax/Modem
One RJ-45 Jack for 10Mb/ 100Mb/ 1000Mb Fast 
Ethernet
One Mini-IEEE 1394 Port
One S-Video-Out Jack (supports HDTV)
One DC-in Jack

Card Reader Embedded 4-in-1 Card Reader (MS/ MS PRO/ SD/ MMC)

ExpressCard Slot ExpressCard/34/54 Slot

Communication AZALIA 56K Plug & Play Fax/Modem v.90/92 Compliant
10Mb/ 100Mb/ 1000Mb Fast Ethernet
(Option) Intel PRO/Wireless 3945ABG Wireless LAN Module with PCIe Interface
(Factory Option) Bluetooth Module - Version 2.0
(Factory Option) PC Camera with USB Interface (300K or 1.3M Pixel)

Power 
Management

Supports ACPI 2.0
Supports Suspend to RAM (S3)
Supports Suspend to Disk (S4)
Supports Soft Off (S5)

Supports Battery Low Suspend
Supports Resume from Modem Ring
Supports Wake on LAN

Power Full Range AC/DC Adapter 20V, 3.25A (65 Watts), 100 - 240V, 50 - 60Hz

6 Cell Smart Lithium-Ion Battery Pack, 4000mAH (44.4W)
OR
6 Cell Smart Lithium-Ion Battery Pack, 4400mAH (48.8W)

Feature Specification
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Environmental 
Spec

Temperature
Operating:   5°C ~ 35°C
Non-Operating: -20°C ~ 60°C

Relative Humidity
Operating: 20% ~ 80%
Non-Operating: 10% ~ 90%

Physical 
Dimensions & 
Weight

Model A Computers:
333mm (w) * 276mm (d) * 24-33mm (h)
2.4 kg Without Battery

Model B Computers:
333mm (w) * 243mm (d) * 24-33mm (h)
2.2 kg Without Battery

Optional Optical Drive Module Options:
DVD/CD-RW Combo Drive Module
DVD-Dual Drive Module

Intel PRO/Wireless 3945ABG Wireless LAN 
Module with PCIe Interface

(Factory Option) PC Camera with USB Interface

(Factory Option) Bluetooth Module - Version 2.0

Model A Only
(Factory Option) Swap Battery - 2 ~ 3 Minutes 
Swap Time

Feature Specification
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Appendix D: Windows XP Information
This Appendix contains information (including control panel information, driver installation etc.) for users of
the Windows XP OS.
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DVD Regional Codes

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South Africa, Middle East & Egypt

3 South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong

4 South & Central America, Mexico, Australia, 
New Zealand

5 N Korea, Russia, Eastern Europe, India & Most of Africa

6 China

Table D - 1 - DVD Region Codes Figure D - 1 - DVD Regions

Changing DVD Regional Codes

Go to the Control Panel and double-click System > Hardware (tab), click Device Manager, then click the + next to DVD/CD-ROM drives.
Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the control
panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is
permanent. This cannot be altered even if you change your operating system or you use the module in another computer.
D - 2 DVD Regional Codes
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Windows XP Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows XP (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of
the Start menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows XP provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers. To see
all controls it may be necessary to toggle off Category View.

Figure D - 2 - Start Menu & Control Panel

Click here to toggle Category View
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Audio Features
You can configure the audio options on your computer from the Sounds and Audio Devices  Windows con-
trol panel, or from the Realtek HD Audio Manager  icon in the taskbar/control panel (this will bring up the
Realtek Audio Configuration menus). The volume may also be adjusted by means of the Fn + F5/F6 key com-
bination.

Figure D - 3 - Realtek Audio Configuration Menus

Sound Volume Adjustment

How high the sound volume can be
set depends on the setting of the vol-
ume control within Windows (and the
volume control function keys on the
computer). Click the Volume icon on
the taskbar to check the setting.
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8 Channel Sound Support
If you wish to configure your system for 8 channel sound support, then the ports below should be used as outputs.
Move the cursor over the appropriate icon (e.g. ) to get information on the connected port, or double-click
the rear speaker/sub woofer icons  to bring up the “Connected device:” dialog box to configure the
output port. Click the S/PDIF icon  to access the S/PDIF menu.

• Side Speaker Out - Connect to S/PDIF Out
• Center/Subwoofer Speaker Out - Connect to Microphone In
• Front Speaker Out - Connect to Speaker/Headphone Out
• Rear Speaker Out - Connect to Line In

Figure D - 4 - 8 Channel Sound Support
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Video Features
Your computer has built-in Intel (Intel 945GM) video. You can switch display devices, and configure display
options, from the Display Properties control panel in Windows as long as the appropriate video driver is in-
stalled.

To access Display Properties in Windows:
1. Click Start, point to Settings and click Control Panel (or just click Control Panel).
2. Double-click Display (icon) - In the Appearances and Themes category.
3. Click Settings (tab) in the Display Properties dialog box.
4. Move the slider to the preferred setting in Screen resolution  (Figure D - 5 on page D - 7).
5. Click the arrow, and scroll to the preferred setting in Color quality (Figure D - 5 on page D - 7).
6. You can also access Display Properties by right-clicking the desktop and scrolling down and clicking

Properties. Click Settings (tab) and adjust as above.
7. Open the Display Properties control panel, and click Advanced (button)  (Figure D - 5 on page D - 7) to

bring up the Advanced properties tabs.
8. Click the Intel(R) Graphics Media Accelerator Driver for Mobile tab, and click Graphics Properties (button)

to make any video adjustments you require.
9. You can also access Graphics Properties from the Windows Intel(R) GMA Driver for Mobile control panel, or

from the taskbar icon .

Dynamic Video Memory Technology
Intel® DVMT 3.0 automatically and dynamically allocates as much (up to 128MB) system memory (RAM) as
needed to the video system (the video driver must be installed). DVMT returns whatever memory is no longer
needed to the operating system.

1
2

3
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Display & Graphics Properties

Figure D - 5 - Display & Graphics Properties

1 2

3

Taskbar Icon

You can also access the controller prop-
erties from the taskbar. Click on the icon
to bring up the menu and scroll to Graph-
ics Properties.

If you cannot see the tray icon go to the
Intel(R) Graphics Media Accelerator
Driver for Mobile tab and click the “Show
Tray Icon” tickbox. Alternatively right-
click the desktop and select Graphics
Options > Tray Icon > Enable.
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You may make changes to the devices, color, schemes, Hot Keys etc. by clicking the appropriate menu item or
button. Click Information (button) to obtain useful information about the graphics properties of the computer,
and see the Support tab in Information to get weblinks to the latest information on the Intel Website.

Figure D - 6 - Intel GMA Driver for Mobile

Function Key Combination

You can use the Fn + F7 key
combination to toggle through
the display options:

• Notebook Only
• External Display Only
• Notebook + External Display

Make sure you give the displays
enough time to refresh.

Intel Display Note

Note that the notebook is the de-
fault Primary display device and
may not be changed.
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Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display or
TV as your display device. A VGA monitor/Flat Panel Display connects to the external monitor port, a TV to
the S-Video-Out jack. The following display modes are available.

Figure D - 7 - Display Options

Intel Display Mode Description

Single Mode One of the connected displays is used as the display device

Twin Mode This mode will drive multiple displays with the same content and resolutions, color quality etc.

Intel(R) Dual Display Clone 
Mode Both connected displays output the same view and may be configured independently

Extended Desktop Mode Both connected displays are treated as separate devices, and act as a virtual desktop

Switching Modes When Using the Power DVD Application

Switch display modes before playing any DVD in the Power DVD Application it is not be possible to switch display
modes while a DVD is playing (you will be required to stop the DVD playing, switch display modes, then start the DVD
playing again).
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Attaching Other Displays
If you prefer to use a monitor or flat panel display, connect it to the external monitor port at the rear of the com-
puter.

1. Attach your external monitor to the external monitor port (or TV to the S-Video-Out jack), and turn it on.
2. Go to the Graphics Properties control panel and click Display Devices.
3. Click to choose the display option from the Multiple Display menu.
4. Click Apply (and OK to confirm the settings change) and OK (button).

Figure D - 8 - Display Devices
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To Enable Intel(R) Dual Display Clone Mode OR Twin Mode
1. Attach your external monitor to the external monitor port (or TV to the S-Video-Out jack), and turn it on.
2. Go to the Graphics Properties control panel and click Display Devices.
3. Click to choose Intel(R) Dual Display Clone or Twin.
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

Figure D - 9 - Display Devices & Settings

Twin Mode Support

The Twin mode option will
only appear if the note-
book and external monitor
support the same resolu-
tion (e.g. 1280 * 800).
Check any documentation
supplied with an external
monitor to see supported
resolutions.

Clone Mode Twin Mode
Attaching Other Displays D - 11
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To Enable Extended Desktop Mode:
1. Attach your external monitor to the external monitor port (or TV to the S-Video-Out jack), and turn it on.
2. Go to the Graphics Properties control panel and click Display Devices.
3. Click to choose Extended Desktop.
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

Figure D - 10 - Desktop Mode

Click the appropriate monitor
icon and drag it to match the
physical arrangement you wish
to use (e.g. the secondary display
may be extended left/right/
above/below  the primary dis-
play).

Click Display Settings to make
any adjustments required.

 Display Settings 
Extended Desktop 

You can have different
Colors, Screen Area and
Monitor Refresh Rates for
each display device pro-
vided your monitor can
support them.

You can drag the monitor
icons to match the physi-
cal layout of your displays.
Icons and programs may
also be dragged between
the displays.
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To Enable Extended Desktop (Display Properties)
1. Attach your external monitor to the external monitor port (or TV to the S-Video-Out jack), and turn it on.
2. Click Start, point to Settings (or click Control Panel) and click Control Panel (if you are in Category View

choose Appearance and Themes).
3. Double-click Display (icon).
4. In the Display Properties dialog box, click Settings (tab).
5. Click the monitor icon (e.g. ), and make sure you have checked “Extend my Windows desktop onto this

monitor.” and click Apply.

Figure D - 11 - Display Properties (Extended Desktop)

2

Click the appropriate mon-
itor icon (e.g. ) to be able
to select the option to ex-
tend the desktop on to it.

In this example the Primary
monitor  is on the left, the
secondary display  is on
the right.

2

1
2

 Display Settings Extended 
Desktop 

Use the control panel to drag the mon-
itors to match the physical arrange-
ment you wish to use. 

You can drag any icons or windows
across to either display desktop,
which makes it possible to have one
program visible in one of the displays,
and a different program visible in the
other display.
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TV Settings
If you are using a TV as a display device adjust the display settings as follows:

1. Attach your TV to the S-Video-Out jack and turn it on.
2. Go to the Graphics Properties control panel and click Display Devices.
3. Choose the television as one of your display devices.
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings and click Television (tab).
6. Choose the appropriate TV system from Video Standard dropbox.
7. Click TV Settings (button) to make any further adjustments supported by your television.

Figure D - 12 - TV Settings
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Power Management Features
The Power Options control panel icon in Windows (see page D - 3) allows you to configure power management
features for your computer. You may conserve power through individual components such as the monitor or hard
disk, or you may use either Stand by or Hibernate mode to conserve power throughout the system.

Power Schemes
You can set your computer to conserve power through individual components by means of Power Schemes.
You can also adjust the settings for each scheme to set the monitor to turn off after a specified time, and the com-
puter's hard disk motor to turn off if the hard disk drive has not been accessed for a specified period of time (if
the system reads or writes data, the hard disk motor will be turned back on). The schemes may also be set to set
a specified time for the system to enter Stand by or Hibernate modes.

Figure D - 13 - Power Schemes

Resuming Operation

Press the Sleep/Resume
key combination (Fn + F4),
or power button to resume
from Monitor or Hard Disk
Stand by.
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Each Windows Power Scheme will also adjust the processor performance of your machine in order to save pow-
er. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery
power).

Choose the Home/Office Desk scheme for maximum performance when the computer is powered from an AC
power source. Choose the Max Battery scheme (bear in mind that this scheme may slow down the overall per-
formance of the computer in order to save power) for maximum power saving when the computer is battery (DC
power) powered. Windows will use Portable/Laptop as the default scheme.

System Power Options
You can use the system power options to stop the computer’s operation and restart where you left off. This sys-
tem features Stand by and Hibernate sleep mode levels (Hibernate mode will need to be enabled by clicking
the option in the Hibernate tab in the Power Options control panel).

Hibernate Mode vs. Shutdown
Hibernate mode and Shutdown are the same in that the system is off and you need to press the power button to
turn it on. When you come back from hibernation, you can return to where you last left off (what was on your
desktop) without reopening the application(s) and file(s) you last used.

Stand by Mode vs. Hibernate Mode
If you want to stay away from your work for just a while, you can put the system on Stand by instead of in hi-
bernation. It takes a longer time to wake up the system from Hibernate mode than from Stand by mode.
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Stand by
Stand by saves the least amount of power, but takes the shortest time to return to full operation. During Stand by
the hard disk is turned off, and the CPU is made to idle at its slowest speed. All open applications are retained
in memory. When you are not using your computer for a certain length of time, which you specify in the oper-
ating system, it will enter Stand by mode to save power. 

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD before it turns the system off.
Although it saves the most power it takes the longest time to return to full operation. You can set your computer
to automatically enter Hibernate mode when the battery power is almost depleted. You will need to enable Hi-
bernate mode from the Hibernate tab in the Power Options control panel. The system will resume from Hi-
bernate mode by pressing the power button.

Figure D - 14 - Enable Hibernation

System Resume

The system can resume from Stand by mode by:

• Pressing the power button

• An incoming call received on the modem (if enabled)

• Network card activity (if enabled)
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Configuring the Power Button
The power button may be set to send the computer in to either Stand by or Hibernate mode. In Stand by mode,
the LED  will blink green. In Hibernate mode the LED will be off (battery) or orange (AC/DC adapter).
If you are in a power saving mode set to save power through individual components (e.g. hard disk, monitor),
the LED will remain green.

Figure D - 15 - Power Options (Advanced - Power Buttons)

(Sleep) Button
Power Button Sleep/ResumeLid

Sleep Button

You may also configure
the Sleep/Resume key
combination (Fn + F4).
In Windows this is re-
ferred to as the Sleep
button.
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Battery Information
Please follow these simple guidelines to get the best use out of your battery.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page D - 22).

Battery Life
Your computer’s battery life is dependent upon many factors, including the programs you are running, and pe-
ripheral devices attached. Power Options (you may set low battery Alarms and actions, and check the Power
Meter from the Power Options control panel), and settings in the OS will help prolong the battery life if con-
figured appropriately.

Figure D - 16 - Power Options (Alarm & Power Meter)

Low Battery Warning

When the battery is critically low, immediately
connect the AC/DC adapter to the computer or
save your work, otherwise, the unsaved data
will be lost when the power is depleted.
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Battery life may be shortened through improper maintenance. To optimize the life and improve its perfor-
mance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason
see “Removing the Battery” on page 6 - 3.

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical out-
let. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the
computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 9 for information on the battery charge status, and to “Battery Information” on page D - 19
for more information on how to maintain and properly recharge the battery pack.)

Conserving Battery Power

To conserve battery power:

Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by
the AC/DC adapter.

Close modem or communication applications when they are not being used.

Remove any unused Express Cards from the computer (Express Cards quickly use up battery power even if the system enters sleep mode).

Disconnect any unnecessary external devices.
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells
emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery
has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged
battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your
computer battery every two years.
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer by
yourself even when you see a message that indicates the battery is critically low, just let the computer use up all
of the battery power and shut down on its own. Disable the Power Options functions in the Control Panel, es-
pecially any Alarms (unclick the tickboxes - see page D - 19) and Schemes (change all the settings to Never -
see page D - 15). As the battery nears the end of its life save and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.

Caution

Danger of explosion if battery is incorrectly replaced.

Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the
manufacturer’s instructions.
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Swap Battery (Optional for Model A Only)
If you have included the optional swap battery in your purchase option it will allow you to change batteries on
your computer without having to shut the computer down. The swap battery’s total operational time is approxi-
mately three minutes; however the swap battery life is dependent upon many factors (see sidebar).

Swapping Batteries
1. Go to the Power Options control panel in Windows.
2. Click Advanced (tab).
3. Select Stand by from the Power buttons pull down menu, under the heading 

“When I close the lid of my portable computer:”
4. Click OK to save the settings, and close the cover of the notebook.
5. The computer will enter Stand by mode (the  LED will blink green*).
6. Remove the currently installed battery, and install the replacement battery 

(see page 6 - 3) within the 3 minute (approx.) operational period.
7. Open the notebook cover and the system will resume.

Figure D - 17 -Power Options (Stand by - Lid)
 

*Swap Battery Indicator

The  icon will blink green for about one minute, and will then change to blink orange for a further two minutes before the computer
shuts down. These times are intended as guidelines only, and may vary depending upon programs and peripheral devices being used.
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Driver Installation
The Device Drivers & Utilities + User’s Manual CD-
ROM contains the drivers and utilities necessary for
the proper operation of the computer. Table 5 lists what
you need to install, and it is very important that the
drivers are installed in the order indicated. 

Only install drivers for modules (WLAN, Bluetooth,
and PC Camera) included in your purchase option.

Installation Methods (Win XP)
You may choose to install the drivers from the autorun
program, or install them manually.

Table 5 - Driver Installation

WinXP SP2 Driver Page #

Install the appropriate Service Pack for WinXP  Page - 26

 Chipset  Page - 27

Video  Page - 27

Audio  Page - 27

LAN  Page - 27

Modem  Page - 28

TouchPad  Page - 28

Express Card/Card Reader  Page - 28

Hot-Key  Page - 29

AutoMail (Manual Driver Installation Only)  Page - 29

Bluetooth  Page - 30

PC Camera  Page - 31

Wireless LAN  Page - 32
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What to Install
This section covers driver and utility installation instruc-
tions for Windows XP Home & Professional. Insert the
Device Drivers & Utilities + User’s Manual CD-ROM,
click Install WinXP Drivers (button) and then click the
appropriate driver name from the Drivers Installer menu
and then follow the instructions to install the driver. Al-
ternatively Click Start and navigate (Browse..) to fol-
low the manual setup instructions.

Figure 5 - Drivers Installer Screen 1

1. Check the driver installation order from Table 5 (the 
drivers must be installed in this order) which is the 
same as that listed in the Drivers Installer menu 
below.

2. Click to select the driver you wish to install, after 
installing each driver it will become greyed out (if you 
need to reinstall any driver, click the Unlock button).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following pages.

Figure 6 - Drivers Installer Screen 2
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Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may
be necessary to uninstall the original driver.To do this go
to the Control Panel in the Windows OS and double-
click the Add/Remove Programs item. If you see the
individual driver listed (if not see below), uninstall it,
following the on screen prompts (it may be necessary to
restart the computer). Go to the appropriate section of the
manual to complete the update/reinstall procedure for the
driver in question.

If the driver is not listed in the Add/Remove Programs
item:
1. Click Start (menu), point to Settings and click Control 

Panel (or click Start > Control Panel). 
2. Double-click System (icon); System (icon) is in 

Performance and Maintenance (category).
3. Click Hardware (tab) > Device Manager (button).
4. Double-click the device you wish to update/reinstall the 

driver for (you may need to click “+”).
5. Look for the Update Driver button (check the Driver 

tab) and follow the on screen prompts.

Windows XP Service Pack 2

Make sure you install Windows XP Service Pack 2 (or a
Windows XP version which includes Service Pack 2) be-
fore installing any drivers. Service Pack 2 includes sup-
port for USB 2.0.

If you have upgraded the system by installing Service
Pack 2 (i.e. your Windows XP version does not include
Service Pack 2) then follow these instructions:

1.Click Start (menu), point to Settings and click Con-
trol Panel (or click Control Panel).

2.Double-click System (icon); System (icon) is in Per-
formance and Maintenance (category).

3.Click the Hardware (tab) > Device Manager (button). 
4.Click “+” next to Other Devices (if its sub-items are

not shown).
5.Right-click Universal Serial Bus (USB) Controller

and select Uninstall > OK (if you don’t see the item
then there is no need to take any further action).

6.Restart the computer and it will find the USB 2.0 con-
troller.
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Chipset (WinXP)
1. Click 1.Install Chipset Driver > Yes from the 

Drivers Installer menu.
OR
Click Start (menu) > Run... and navigate 
(Browse..) to 
D:\Drivers\Chipset\Setup.exe and click OK.

2. Click Next > Yes > Next.
3. Click Finish to restart the computer.

Video (WinXP)
1. Click 2.Install Video Driver > Yes from the 

Drivers Installer menu. 
OR
Navigate (Browse..) to 
D:\Drivers\Video\Setup.exe and click OK.

2. Click Next > Yes.
3. Click Finish to restart the computer.

Audio (WinXP)
1. Click 3.Install Audio Driver > Yes from the 

Drivers Installer menu. 
OR
Navigate (Browse..) to 
D:\Drivers\Audio\Setup.exe and click OK.

2. Click Next (click Continue Anyway if asked if 
you want to continue at any time).

3. Click Finish to restart the computer.

LAN (WinXP)
1. Click 4.Install LAN Driver > Yes from the 

Drivers Installer menu. 
OR
Click Start (menu) > Run... and navigate 
(Browse...) to D:\Drivers\LAN\setup.exe and 
click OK.

2. Click Next > Install.
3. Click Finish.
4. The network settings can now be configured.
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Modem (WinXP)
1. Click 5.Install Modem Driver > Yes from the 

Drivers Installer menu. 
OR
Click Start (menu) > Run... and navigate 
(Browse...) to 
D:\Drivers\Modem\ssetup.exe and click OK 
(click Continue Anyway if asked if you want 
to continue at any time).

2. Click OK.
3. The modem is ready for dial-up configuration.

TouchPad (WinXP)
1. Click 6.Install TouchPad Driver > Yes from 

the Drivers Installer menu. 
OR 
Click Start (menu) > Run... and navigate 
(Browse..) to 
D:\Drivers\Touchpad\SETUP.EXE and click 
OK.

2. Click Next > Next (click Continue Anyway if 
asked if you want to continue at any time).

3. Click Finish to restart the computer.

ExpressCard/Card Reader (WinXP)
1. Click 7.Install Express Card Driver > Yes from the 

Drivers Installer menu. 
OR 
Click Start (menu) > Run... and navigate 
(Browse...) to 
D:\Drivers\ExpressCard\setup.exe and click OK.

2. Click Next > Next.
3. Click Finish to restart the computer.

Modem Country Selection

Be sure to check if the modem country selection is appropri-
ate for you (Control Panel > Phone and Modem Options).
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Hot-Key (WinXP)
1. Click 8.Install Hotkey Utility > Yes from the 

Drivers Installer menu. 
OR 
Click Start (menu) > Run... and navigate 
(Browse..) to 
D:\Drivers\Hotkey\Setup.exe and click OK.

2. Choose the language you prefer, and click OK.
3. Click Next.
4. Click Finish to restart your computer.

AutoMail (WinXP)
The AutoMail Driver must be installed manually as
per the instructions below:

1. Click Start (menu) > Run... and navigate 
(Browse..) to 
D:\Drivers\AUTOMAIL\SETUP.EXE and 
click OK.

2. To continue click Next > Next > Finish.

Module Drivers
See the following pages for the driver installation pro-
cedures for any of the optional modules included in
your purchase configuration.

Wireless LAN & Bluetooth Modules

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices
aboard aircraft is usually prohibited. Make sure the module(s)
are OFF if you are using the computer aboard aircraft.

Power Toggle for the Wireless LAN and Bluetooth 
Modules

Enable power to the modules as follows:

Fn + F11 = Wireless LAN Module Power Toggle
Fn + F12 = Bluetooth Module Power Toggle

The LED indicator  will be green if the WLAN module is on,
and orange if the Bluetooth module is on.
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Bluetooth Driver Installation
1. Make sure the module is powered on, then 

insert the Device Drivers & Utilities + User’s 
Manual CD-ROM into the CD/DVD drive. 

2. Click Install WinXP Drivers (button). 
3. Click 9.Install Bluetooth Driver > Yes from 

the Drivers Installer menu.
4. Choose the language you prefer, and click OK.
5. Click Next.
6. Click the button to accept the license agree-

ment, then click Next.
7. Click Next > Next > Install.
8. Click Finish > Yes to restart the computer.
9. The IVT Corporation BlueSoleil - Main 

Window screen appears on restart.
10. You can configure the settings at any time by 

going to the IVT Corporation BlueSoleil - 
Main Window control panel (Start > Pro-
grams/All Programs > IVT BlueSoleil), or by 
clicking the taskbar icon .

11. View the BlueSoleil User Guides from the 
Help Menu (press F1) in the IVT Corporation 
BlueSoleil - Main Window control panel.

Figure 7 - Bluetooth Control Panel & User Guides
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PC Camera Driver Installation

1. Press the Fn + F10 key combination to power 
on the PC Camera module (click Cancel if you 
see a “New Hardware Found” message).

2. Make sure the module is powered on, then 
insert the Device Drivers & Utilities + User’s 
Manual CD-ROM into the CD/DVD drive. 

3. Click Install WinXP Drivers (button). 
4. Click 10.Install CCD Driver > Yes from the 

Drivers Installer menu.
5. Choose the language you prefer and click OK.
6. Click Next > Finish to restart the computer.
7. Run the BisonCap application program from 

the BisonCam shortcut on the desktop, or from 
the BisonCam item in the Start > Programs/
All Programs menu (if the hardware is turned 
off use the Fn + F10 key combination to turn it 
on again).

BisonCap
BisonCap is a video viewer useful for general purpose
video viewing and testing, and can capture video files
to .avi format.

Latest PC Camera Driver Information

Check the PC Camera CD, and any accompanying insert pag-
es, for the latest updated information on the PC Camera driver,
which may override the information provided here.
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Intel WLAN Driver Installation
1. Make sure the module is powered on, then 

insert the Device Drivers & Utilities + User’s 
Manual CD-ROM into the CD/DVD drive. 

2. Click Install WinXP Drivers (button). 
3. Click 11.Install WLAN Driver > Yes from the 

Drivers Installer menu.
4. Click Install Software (button).
5. Click the button to accept the license and click 

Next > Next > OK.
6. Click OK to complete the installation.
7. Configure the settings by going to the Intel (R) 

PROSet Wireless control panel (Start > Pro-
grams/All Programs > Intel PROSet Wire-
less), or by double-clicking the taskbar icon .

Figure 8 - Intel PROSet/Wireless

User Guide

Insert the Device Drivers & Utilities + User’s Manual CD-ROM
and navigate (Browse..) to D:\Drivers\Options\WLAN\Autorun.exe.
Click View User Guide (button).

You can also view the Help menu from the Intel(R) PROSet/Wire-
less control panel (or press the F1 key).

Intel PRO Wireless 2200BG 
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